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Evaluation Board for the AD4000 Series 16-/18-Bit Precision SAR ADCs

FEATURES

Fully featured evaluation board for 10-lead precision ADCs

Versatile analog signal conditioning circuitry

On-board reference, reference buffers, and ADC drivers

PC software for control and data analysis of time and
frequency domain

System demonstration platform-compatible (EVAL-SDP-CH1Z)

EVALUATION BOARD KIT CONTENTS

AD4000/AD4001/AD4003 evaluation board (see Table 6)
12V wall adapter power supply

EQUIPMENT NEEDED

SDP-H1 board (EVAL-SDP-CH1Z)

Precision signal source

Cable (SMA input to evaluation board)

Standard USB A to mini-B USB cable

Band-pass filter suitable for 16-bit and 18-bit testing
(value based on signal frequency)

GENERAL DESCRIPTION

The AD4000/AD4001/AD4003 family evaluation board covers
the ease of use, 16-/18-bit, precision successive approximation
register (SAR) analog-to-digital converters (ADCs). The AD4000/
AD4001/AD4003 are low power, 16-bit/18-bit, precision SAR
ADC:s that offer very high performance with throughputs up to
2 MSPS. The evaluation board is designed to demonstrate the
performance of the AD4000/AD4001/AD4003 family of ADCs
and to provide an easy to understand interface for a variety of
system applications. A full description of these products is
available in their respective data sheets, which must be consulted
when using this evaluation board.

The EVAL-AD4000FMZ/EVAL-AD4001FMZ/EVAL-
AD4003FMCZ evaluation boards (see Figure 1) are ideal for use
with the Analog Devices, Inc., high speed system demonstration
platform (EVAL-SDP-CH1Z). These evaluation boards interface
to the SDP-H1 board via a 120-pin connector. SMA connectors,
JP2 and JP3, are provided for the low noise analog signal source.

On-board components include a high precision buffered band gap
5.0 V reference (the ADR4550), a reference buffer (the ADA4807-1),
a common-mode buffer (the ADA4807-1), a signal conditioning
circuit with two op amps (the ADA4807-1), and a power supply to
derive the necessary voltage levels to supply all voltage needs.

EVALUATION BOARD PHOTOGRAPH
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EVALUATION BOARD HARDWARE
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Figure 2. Simplified Evaluation Board Block Diagram

SETTING UP THE EVALUATION BOARD

Figure 2 shows the simplified evaluation board block diagram.
Figure 25 shows the evaluation board schematic. The board
consists of the ADC, U1, with a reference, U6 (ADR4550), and
ADC drivers, U12 and U14, the ADA4807-1 for the AD4003/
AD4001 and the ADA4805-1 for the AD4000 (see Table 5).
The user also has an option to use a low power, fully differential
ADC driver, U2, by populating the ADA4940-1. The evaluation
board is a flexible design that enables the user to select
components in addition to operating from an adjustable bench
top power supply.

POWER SUPPLIES

The system demonstration platform (SDP-H1) board supplies
12 V to power necessary rails for the AD4000/AD4001/AD4003
evaluation board.

Table 1. Power Supplies Provided on the Board

Power Supply (V) Function Components Used

5,7 (default)’ Positive rail ADP7118

-5, -2.5 (default)’ Negative rail ADP2370, ADM660,
ADP7182

1.8 ADC power ADP7118, ADP5300

33 Vorve (digital power) | ADP7118

! See Table 2.

The 7 V amplifier positive rail (+Vs) is generated from U17,
(the ADP7118). The —2.5 V negative amplifier rail (-Vs) is
generated by a combination of U3 (the ADP2370), U7 (the
ADMG660), and U21 (the ADP7182).

Each supply is decoupled where it enters the board and again at
each device. A single ground plane is used on this board to
minimize the effect of high frequency noise interference.

In addition to this, there is also the ability to power the board
from a bench top power supply. The screw terminals, ]2 and J3, are
provided for this function. When bench power is used, the on-
board power supplies are no longer required. Solder links also
must be changed: SL1 = SL2 = SL5 = SL6 = SL7 = SL8 = SL9 = B.

REFERENCE, REFERENCE BUFFER, AND COMMON-
MODE BUFFER

An external 5 V reference (U6, ADR4550) is used by default to
supply the ADCs directly. However, the user can also use one of
the 2.5V, 3.3V, and 4.096 V references by changing the reference
(U6) on the board. There is also an option to use a lower power
reference (U22, ADR3450). Note that the ADR3450 cannot
accept input voltage beyond 5.5 V. The ADA4807-1 is used as a
reference buffer (U16) and common-mode buffer (U18) by
default. However, it can also be replaced by the AD8031 if
needed without compromising the performance.

SDP-H1 CONTROLLER BOARD

The evaluation board uses the SPI interface and it is connected
to the high speed controller board for the system demonstration
platform (SDP-H1) controller board. The SDP-H1 board requires
power from a 12 V wall adapter. The SDP-H1 has a Xilinx®
Spartan 6 and an ADSP-BF527 processor with connectivity to the
PC through a USB 2.0 high speed port. Controller boards allow
the configuration and capture of data on daughter boards from
the PC via USB.
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The SDP-H1 has a FMC low pin count (LPC) connector with
full differential LVDS and singled ended LVCMOS support. It
also has the 120-pin connector, found on the SDP-B, which
exposes the Blackfin processors peripherals. This connector
provides a configurable serial, parallel I’C and SPI, and GPIO
communications lines to the attached daughter board.

SOLDER LINKS

The three-solder link options on the board are configured
depending on which generic of the ADC is on the specific
evaluation board as described in Table 3.

Table 2. Table of Jumper Detail with Factory Default Setting

Table 3. Table of Jumpers Specific to 10-Lead Precision ADCs

Link | Default | Configuration Generic
SL4 A Differential input AD4001, AD4003
SL4 | B Single-ended or AD4000

pseudo differential

Link | Default | Function Comment
SL1 A +Vs Change to B if using bench
supplies
SL2 | A -Vs Change to B if using bench
supplies
SL5 | A +Vs Change to B if using bench
supplies
SL6 | A -Vs Change to B if using bench
supplies
SL7 | A VDD for Change to B if using bench
ADC supplies
SL8 | A -Vs Change to B if using bench
supplies
SL9 | A +Vs Change to B if using bench
supplies
LK2 | A VREF Change to B if using the ADR3450
LK5 | B SDI Change to A if using V_DRIVE
JP1 B FSEL (U3) Change to A if using Ground
JP2 B ADC Change to A if using FDA
drivers ADA4940-1
JP3 B ADC Change to A if using FDA
drivers ADA4940-1
JP4 | B ADC Change to A if using FDA
drivers ADA4940-1
JP5 B ADC Change to A if using FDA
drivers ADA4940-1
JP7 | B V_DRIVE Change to A if using external
3.3V forV_DRIVE
JP8 B STOP (U20) | Change to A if using CNV_FMC
from SDP-H1 connector

ANALOG INPUTS

The analog inputs to the evaluation board are SMA connectors,
J6 and J10. These inputs are buffered with dedicated amplifier
circuitry (U12 and U14), as shown in Figure 25. The circuit allows
different configurations, input range scaling, filtering, addition of a
dc component, and use of different op amp and supplies. The
analog input amplifiers are set as unity-gain buffers at the factory.

The default configuration sets both U12 and U14 at midscale,
generated from a buffered reference voltage divider (VCM).

The evaluation board is factory configured for providing either
a single-ended path or a fully differential path.

For dynamic performance, a fast Fourier transform (FFT) test
can be performed by applying a very low distortion ac source.

For low frequency testing, the audio precision source (such as the
SYS-2700 series) can be used directly because the outputs on these
are isolated. Set the outputs for balanced and floating ground.
Different precision sources can be used with additional filtering.

Because the evaluation board uses the amplifiers in unity-gain,
the noninverting input has a common-mode input with a 590
resistor divider, and it must be taken into account when directly
connecting a source.
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EVALUATION BOARD SOFTWARE

INSTALLING THE SOFTWARE

The evaluation board software can be downloaded from the
relevant product page on the Analog Devices website.

Install the software before connecting the SDP-H1 board to the
USB port of the PC. This ensures that the SDP-H1 board is
recognized when it connects to the PC.

1.  Start the Windows® operating system and download the
software from the relevant product page on the Analog
Devices website.

2. Unzip the downloaded file. Run the setup.exe file.

3. After installation is completed, power up the evaluation
board as described in the Power Supplies section.

4.  Plug the evaluation board into the SDP-H1 board and the
SDP-H1 board into the PC using a USB cable.

5. When the software detects the evaluation board, proceed
through any dialog boxes that appear to finalize the
installation.

The default location for the software is the following:
C:\Program Files\Analog Devices\AD40XX Evaluation
Software\EVAL-AD40XX.

This location contains the executable software and example files.

INSTALLATION STEPS

Proceed through the installation, allowing the software and
drivers to be placed in the appropriate locations. Connect the
SDP-H1 board to the PC only after the software and drivers are
installed.

There are two parts to the software installation. First, install the
software related to the evaluation board, as follows:

1. Launch the evaluation board software installation by
clicking the setup.exe file. The software installation
window opens as shown in Figure 3.

S A Evaluon Seftues e |
ADMDKK Evaluation Soltware Install

B ix stranghy Rcommantar that you st sl prageams baloes aning this instalar
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Figure 3. Evaluation Software Install

Choose the folder location for installation and click Next.
The default folder is shown in Figure 4.
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Figure 4. Destination Directory

Accept the National Instruments software license
agreement and click Next.
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Figure 5. License Agreement

Click Next again to install the software.
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5.

6.

A pop up window opens and displays a bar showing the
installation progress, as shown in Figure 7.
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Figure 7. Overall Progress

Click Next to complete the installation and to launch the
SDP-H1 driver installation as shown in Figure 9.
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Figure 8. Installation Complete

The second part of the software installation is the drivers
related to the SDP-H1 board. These drivers must be
installed for the evaluation board to function correctly.

(s Please wait while Setup is loading...

werifving installer: 47%:
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Figure 9. Beginning of SDP-H1 Driver Installation

7.

8.

9.

u ADTSDP Drivers 2,2,95.68 Setup

install the ADI SDP-H1 driver.

u ADLSDP Drivers 2,2.95.68 Setup

Welcome to the ADI SDP Drivers
2.2.95.68 Setup Wizard

Thiz wizard will guide ywou through the installation of ADI SDP
Drivers 2,2,95.68,

1t is recommended that vou close all other applications
befare starting Setup. This will make it possible to update
relewvant system Files without having to reboot your
computer,

Click Mext bo continue.

Cancel

The ADI SDP driver setup wizard opens. Click Next to

=) = s

Figure 10. ADI SDP Drivers Setup Wizard

Choose the installation location and click Install; the
default folder is shown in Figure 11.

u ADISDP Drivers 2,295,068 Setup

Choose Install Location
Chaoose the folder in which to install ADT SDP Drivers 2,2,95.68,

>

Setup will install ADI SOF Drivers 2,2,95.68 in the following Folder. Toinstall in a different
folder, click Brawse and select another Folder. Click Install ko start the installation.

Destination Folder

Browse...

Space required: 23.4MB
Space available: 34.7G8

| < Back H Install ] | Cancel

Figure 11. Choose Install Location

Installing
Please wait while ADI SDP Drivers 2.2.95.68 is being installed.

>
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n
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Figure 12. Installing
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10. Click Close to complete the installation.

3| ADI SDP Drivers 2.2.95.68 Setup = =@ | =
Installation Complete
Setup was completed successfully, u
Completed
Extract: WinlsBCoInstaller.dll,.. 100% -

Extract: adisdp_x64.cat... 100%

Extract: AdiSdp_x64.inf... 100%

Extract: dpinst.exe... 100%

Installing Drivers

Execute: "C:\Program FilesiAnalog Devices\SDP\DriversR 2\ dpinst . exe” fsw fsa fpath ...
Driver Install exit code = -1073741205

Oukput Falder: C:YProgram Files\Analag Devices\SDP\DriversR2

Created uninstaller: C:\Program Files\Analog Devices|SDPYDriversR24uninst . exe
Completed il

m

< Back. Cancel

Figure 13. Installation Complete

When you first plug in the SDP-H1 board via the USB cable
provided, allow the new Found Hardware wizard to run. You

can check that the drivers and the board are connected correctly by

looking at the Device Manager of the PC. Analog Devices
System Development Platform (32MB) appears under ADI
Development Tools.

A Computer Management
Eile Action View Help
= | 2[E) HE &
& Computer Management (Local|
a [} System Tools
- (5 Task Scheduler
[&] Event Viewer
@] Shared Folders
- ¥ Local Users and Groups
- @ Relizbility and Performe
3 Device Manager

DI Development Tools
Analog Devices System Development Platform (32ME)
Cemputer

(a Disk drives
isplay adapters

/CD-ROM drives

785 Human Interface Devices

- IDE ATA/ATAPI controllers

&= Keybosrds

4 £ storage
{29 Dick Management
= Services and Applications i )% Mice and other pointing devices

- B Monitors
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Figure 14. Device Manager

BOARD OPERATION/CONNECTION SEQUENCE
The following is the board operation/connection sequence:

1. Connect the SDP-H1 controller board to the evaluation
board with the J5 connector (screw into place as required).
The software is configured to find the evaluation board on
either connector of the SDP-H1 board.

14981-012

2. Power the board with the appropriate supply as described

in the Power Supplies section.
3. Connect to the PC with the USB cable.

4. Launch the software. Click Start > All Programs > Analog

Devices\ AD40XX Evaluation Software\EVAL-AD40XX.

5. Apply the signal source and capture the data.

RUNNING THE SOFTWARE WITH THE HARDWARE

CONNECTED

To run the program, take the following steps:

1. Click Start > All Programs > Analog Devices > AD40XX

Evaluation Software > EVAL-AD40XX. To uninstall the
program, click Start > Control Panel > Programs and

Features > Analog Devices AD40XX Evaluation Software.

2. The software automatically seeks to find the hardware
connected; therefore, when no hardware is connected, it
displays a connectivity error (see Figure 15) when the
software is launched. Connect the evaluation board to the

SDP-H1 and connect the SDP-H1 to the USB port of the PC,

wait for a few seconds, click Rescan, and then follow the
instructions.

I: Harduware Select E3

Mo ratching systern found, Press Rescan to retry or
Cancel to abort,

If wour SDP is recently connected, it may be in the
process of booting, Wait ~40secs and Rescan,

Prewvious [t

Rescan Cancel

Figure 15. SDP-H1 Board Not Connected to the USB Port Error

Select

3. If Cancel is clicked, a message appears as shown in
Figure 16.

s

==

[ 0P &P Errar!

l SDPERROR 110005: fio connection
made

L ok |

14981-015

Figure 16. SDP-H1 Board Not Connected to the USB Port Error

4. The software then connects to the board and displays the
message shown in Figure 17.

Systern Development Platfiorm Wait EZ

Wfaiting for operation to complete and

Cancel

Figure 17. Software Connects to SDP-H1 Board

14981-016

5. When the board is correctly detected, the software panel
opens.
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SOFTWARE OPERATION

When the software launches, the panel opens and the software
looks for the hardware connected to the PC. The software
detects the generic attached to the PC and the product panel
then launches as shown in Figure 18.

|} AnaIOQ-]jev'i'ces h[iamu)(, Ease of Use Precision &ER’ADCA EE_ET

.Eile Edit Help .

| : ANALOG
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_\';Tfta 2 Reference|_| y l Span Compressian | n

PEY i | High-Z Mode j 0]
L

+.098Y Turbo Mode J
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Throughput 2.5V 10F 1 Read Register
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@ span Compression
R @ High-Z Mode
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INTERFACE
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|0
GIDI Span Compression @
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.Data analysis complete “Wersion 1.1.0.0 Busy 6

14981-017

Figure 18. Setup Screen

Rev. B | Page 8 of 24



UG-1042

DESCRIPTION OF THE USER PANEL

The following is the description of the user panel.

The File menu (Label 1 in Figure 18) has the choice of the
following options:

e  Save Captured Data allows the user to save the current
captured data for later analysis, and the file format is .csv.
The user is prompted to choose or enter the path of the file
in the Save As pop-up (see Figure 19); save to an
appropriate folder location.

¢ Load Captured Data; the Load File pop-up opens where the
user is prompted to load previously captured data in .csv
format for analysis.

e  Take Screenshot allows the user to save the current screen
capture as .jpg.

e  Print Screenshot allows the user to save the current screen
capture as .pdf.

e  Exit stops running the application software.

I: Save As @
Save jn ADAI Evaulation Software v @ E-
i Mo items match your search,
)
Recent Places
|

Desktop

Libraries

Computer
[
a
Metwark
File name: > | 0K ‘

Save as bpe: ‘ Comma Separated Yalue [%.csv) - | | Cancel ‘

14981-050

Figure 19. Save As Dialog Box

The Edit menu (Label 1 in Figure 18) provides the option
(Reinitialize to Default Values) to reset the software to its
initial state.

The Help menu (Label 1 in Figure 18) offers information about the

Analog Devices Website
e  User Guide

e  Context Help

e About

When hardware is connected to the USB port, the software
automatically detects which generic is connected and displays it
(Label 2 in Figure 18).

The Throughput box is Label 3 in Figure 18. The default
throughput (sampling frequency) is 1.75 MSPS. The user can
adjust the throughput to minimum of 10 kSPS. If the user enters
a value larger than the ability of the existing device, the software
reverts to the maximum throughput.

The Voltage Reference drop-down menu is Label 4 in Figure 18.
By default, this reference is 5 V (ADR4550 on-board reference).
The minimum/maximum voltage calculations are based on this

reference voltage. If the user changes the reference voltage, this
input must be changed accordingly.

Click Single Capture to perform a single capture and click
Continuous Capture to perform a continuous stream capture
from the ADC. (Both are noted with Label 5 in Figure 18.)

Select Samples (Label 6 in Figure 18) to analyze data using the
particular number of samples. The maximum number of samples
the software can support is 524,288.

Four capture tabs (Label 7 in Figure 18) display the data in
different formats, as follows:

e  Waveform
e  Histogram
e FFT

e  Summary

Click Enable Status Bits (Label 8 in Figure 18) to enable the
content of status header. Status bits can be clocked out at the

end of the conversion data using six extra clocks when it is
enabled.

Click Span Compression (Label9 in Figure 18) to enable ADC
span compression feature. In single-supply applications, the use
of span compression increases the headroom and footroom
available to the ADC driver by reducing the input range 10%
from the top and bottom of the range while still accessing all
available ADC codes.

Click High-Z Mode (Label 10 in Figure 18) to enable the internal
high-Z mode. Enabling this mode allows the low input current
for the ADC and improves THD performance using low power/
bandwidth precision ADC drivers for slow/dc type signals.

Click Turbo Mode (Label 11 in Figure 18) to enable it and run
the ADC at full throughput of 2 MSPS.

Click Register Read (Read Register (Label 12 in Figure 18) to
see if any of ease of use features are enabled, including span
compression, high-Z mode, turbo mode, an overvoltage
condition (which is a sticky bit) and the status bits.

Clicking Enable Status Bits enables the six status bits and
content of the six bits is updated and displayed in the Status
Header section (Label 13 in Figure 18), after clicking single or
continuous capture. Note that the overvoltage clamp flag status
bit updates on a per conversion basis.

When the Busy indicator (Label 14 in Figure 18) is lit, the user
must wait until the software completes the data analysis.

To exit the software, select File > Exit.

Within any of the chart panels, the tools shown in Table 4 allow
user control of the different chart displays.

Table 4. Graphical User Interface (GUI) Tools

Symbol Description

o This tool controls the cursor, if present.
This tool zooms in and out.

ﬂi This tool is used for panning.
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The evaluation software allows the user to export the raw data
or image. Right clicking any of the four capture tabs (Waveform,
Histogram, FFT, and Summary) open the window as shown in
Figure 20, and the user can either export raw data in Excel
format or save image in .bmp, .eps, or .emf format.

Rev. B | Page 10 of 24
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Figure 20. Export Raw Data or Image
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WAVEFORM CAPTURE

Figure 21 illustrates the waveform capture. The input signal is a
1 kHz sine wave. The waveform analysis reports the amplitudes
recorded from the captured signal in addition to the frequency of
the signal tone.

AD400X Evaluation Software 3591'6%%

. Configure.: wavefarm :.Histogram._- FET | Summary Samples| 131072 x| | Single Capture | |C0ntinu0us Capture| @

123763 [

A

100000
80000
60000
40000
20000

o
-20000

Code

-40000

-60000

-20000

-100000

Bl
10998 14000 16000 15000 22000 24000
Time

-123741

Waveform analysis

Pk-pk Amplitude | 9.4415283y | 247504 | op Mean | 0.0037658 v (98718 | cp

Max Amplitude | #.7211838 | 123763 || gp Standard Deviation | 3.3389288|v | 87528 || gp

Min Amplitude | -+7203448 | -123741| cp Frequency i‘-DD? kHz

14981-018

Data analys.is complete Vers.iun 1.1.0.0 Busy .

Figure 21. Waveform Tab
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ACTESTING—HISTOGRAM

The ac testing histogram tests the ADC for the code distribution
for the ac input, computes the mean and minimum/maximum
amplitude and LSB size of the converter. Raw data is captured
and passed to the PC for statistical computations. To perform a
histogram test, click the Histogram tab and click Sample or
Continuous stream Note that an ac histogram needs a quality
signal source applied to the J6 and J10 input connectors. Figure 22
shows the histogram for a 1 kHz sine wave applied to the ADC
input and illustrates the different measured values for the data
captured.

AD400X Evaluation Software

Canfigure Wavefarm | Histogram | FrT | Summary Samples

DC TESTING—HISTOGRAM

More commonly, the histogram is used for dc testing where the
user tests the ADC for the code distribution for dc input, computes
the mean and standard deviation, or transition noise, of the
converter, and displays the results. Raw data is captured and
passed to the PC for statistical computations. To perform a
histogram test, click the Histogram tab and click Start Stream.
Note that a histogram test can be performed without an external
source using a Vrer/2 (590 Q resistor divider) at the ADC input.
To test other dc values, apply a source to the J6 and J10 input
connectors. It may be required to filter the signal to make the dc
source noise compatible with that of the ADC.

ANALOG
DEVICES

131072 Z‘ | Single Capture | |C0ntinuuus Capture| @

280007

26000

24000

22000

20000

12000

Occurance

16000

14000

12000

10000

8000~

-120000 -100000 -20000 -60000 -40000 -20000

Histogram analysis

Max Amplitude | 47211838/ | 123763 L5B
Min amplitude | -4.720344¢ y  [-123741 | |cp
DC Offset/Mean | 0.0037658 |y |99 LSE
Transition Noise | 3.3389289 | 873528 LSE

Data analys.is complete

= [
20000 40000 50000 s0000 100000 120000

Pk-pk Amplitude | 9.44153 |y | 247504 | Lgp

pas |B.6752 |y

LSe 38147 L

Histogram width | 247504 | Lsp

14981-019

‘ersion 1.1.0.0 Busy ‘

Figure 22. Histogram Tab, Histogram Captured for Sine Wave
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ACTESTING—FFT CAPTURE

The traditional ac characteristics of the converter can be
displays on the FFT tab. As in the histogram test, raw data is
captured and passed to the PC where the FFT is performed
displaying signal-to-noise ratio (SNR), signal-to-noise-and-
distortion ratio (SINAD), total harmonic distortion (THD),
and spurious-free dynamic range (SFDR). The data can also

be displayed in the time domain. To perform an ac test, apply

a sinusoidal signal to the evaluation board at the SMA inputs, J6
and J10. Low distortion, better than 100 dB, is required to allow
true evaluation of the device. One possibility is to filter the input
signal from the ac source. A band-pass filter can be used, and

Furthermore, if using a low frequency band-pass filter when
the full-scale input range is more than a few volts peak-to-peak,
use the on-board amplifiers to amplify the signal, thus preventing
the filter from distorting the input signal.

Figure 23 displays the histogram of the captured data that includes
the following:

e The spectrum information

e The fundamental frequency and amplitude in addition to
the second to fifth harmonics

e The performance data (SNR, dynamic range, THD,
SINAD, and noise performance)

its center frequency must match the test frequency of interest.

AD400X Evaluation Software 3%'@:'&%%

| Configure | Waveform | Histogram | FFT | Summary
| | |

Samplesi. 1_310?2 z‘[ Single Capture ]|C0ntinu0usCapture| o

Amplitude {dB)

-160 !
-180 :
200
] 200000 400000 600000 500000 999984.7412
Frequency (Hz)
FFT Analysis
Max amplitude | 4.721184 )y [ 123763 | Lse Fund. Frequency | 100708 | kHz SNR|9842  |gp  Binwidth|1526  |Hz
Min Amplitude | -4.72034!|v | -123741 | Lse Fund. amplitude | -0.5007 | daFs THD|-111.45 |dB SFDR|112.53 dB
Pk-pk Amplitude | 9.441528]v | 247504 | LsB Dynarnic Range | 99,1951 | dpFs SINAD | 98.2 4B
DC|0.003766 v |99 Lse RMS | 6.675161) v Naise Floor|-143.87 |4

Show Harmonic Cont_e_nt|

Data ana'l'y sis comp'l ete

14981-020

“ersion 1.1.0.0 'Busy .

Figure 23. FFT Tab (AD4003 Running in Turbo Mode)
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SUMMARY TAB

The Summary tab captures all the display information and
provides them in one panel with a synopsis of the information
including key performance parameters, such as SNR and THD.

AD400X Evaluation Software

Qotvices

;. g ! T l H\stagram“; Fﬁ_i_summary | gamples_ 131072 z| [ Single Capture ] |Cont|nuous Capture| @
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123763 i ﬂ‘ ﬂ; o ;'h'l, r m 0
100000 [ IR L .,l_k
AR ATRRTATR ARVRRRTRRRRR -
—sonn AL TR T
TETTITI il J lI ‘l II | J' i o= 40
50000 | ‘l i '..l L LA i)
25000 [ il g l{ 1 [Ty | 450
| 0
g o U A T e =g
{ |I T l T 1 | a
= VRN AR AR A I I £
-25000 f il ]I T {I J i <-100
_sonon (AL L B AR
RS T AT AAMRS AR
-75000 T B LN} ‘l 1Tl
; AR AR MR PR
100000 i lj i i U ,IJ:
-123741 2 v : il 500000 999984.74:
13034 17500 20000 22500 25000 27326 Frequeney (s
Time
HIStOgram Analysis Surmmary
28000
oennn- o e e
24000 Pk-pk &mp| g 44153 |y | 247504 | LSB Dynamic Range | 99,195 |dB
, 22000 DC Offset/Mean| 0.003765 |y 08718 | LS8 SMR 98418 |gp
2 20000 5 : ;T : T
T yano0 Transition Noise | 2.33803 | 87528 LSE THD | -111.454 dp
316000 Fund Freg. | 1.00708 |2 S/N+D 98,204  |dp
14000 Fund amplitude| 0501 |ggFs '—93539-147 o
12000 — ! -
10000 RMS[6,67516 |\ SFDR 112529 4p
2000~ i e t
-150000 -50000 0 50000 100000 150000
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Data analysis complete

Wersion 1,1.0.0 Busy .

Figure 24. Summary Tab, Shows All Captured Windows
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TROUBLESHOOTING
SOFTWARE
To troubleshoot the software, take the following steps:

1.

Always install the software before connecting the hardware to
the PC.

Always allow the install to fully complete (the software is a
two-part installation, the ADC evaluation software and the
SDP-H1 drivers). A restart is recommended after
installation is finished.

When the user first plugs in the SDP-H1 board via the USB
cable provided, allow the new Found Hardware Wizard to
run, which may take a little time. However, allow this to
happen before starting the software.

If the board does not appear to be functioning, ensure that
the ADC evaluation board is connected to the SDP-H1 board
and that the board is being recognized in the Device Manager,
as shown in Figure 14.

If connected to a slower USB port where the SDP-H1 cannot
read as quickly as it needs to, a timeout error may result. In
this case, it is advised not to read continuously, or
alternatively, to lower the number of samples taken.

Rev. B | Page 15 of 24

HARDWARE
To troubleshoot the hardware, take the following steps:

If the software does not read any data back, do the following:

a.  Check that the power is applied within the power
ranges described in the Power Supplies section.

b.  Using a voltmeter, measure the voltage present at each
of the test points: +Vs, —Vs, IPSV_VDD, VDD_1P8YV,
+3P3V, +5V, and REFland common-mode voltages
(REF/2) at IN+ and IN- to ensure that they are
correct. The SDP-H1 board LED1 must be lit.

c.  Launch the software and read the data. If nothing
happens, exit the software.

d. Power down the board and relaunch the software.

e. Ifno data is read back, confirm that the ADC evaluation
board is connected to the SDP-H1 board and that the
board is being recognized in the Device Manager, as
shown in Figure 14.

When the user is working with the software in standalone/

offline mode (no hardware connected) and later chooses to

connect hardware, close and relaunch the software.
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EVALUATION BOARD SCHEMATICS
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Figure 25. ADC Evaluation Board, Power Supplies
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Power Supply for ADC Power supply for V_DRIVE
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Figure 26. ADC Evaluation Board, Voltage Reference, Common-Mode and Reference Buffers
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Figure 29. ADC Evaluation Board Silkscreen, Top Layer
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Figure 30. ADC Evaluation Board, Layer 1
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Figure 31. ADC Evaluation Board, Layer 2
Figure 32. ADC Evaluation Board, Layer 3
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Figure 33. ADC Evaluation Board, Layer 4
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PRODUCTS ON THIS EVALUATION BOARD

AD4000/AD4001/AD4003 BILL OF MATERIALS

Table 5. Bill of Materials

Name Part Description Manufacturer Part Number Stock Code

U1 16-/18-bit,2 MSPS, precision SAR Analog Devices See Table 3 SeeTable 3
ADC in 10-lead MSOP

U2 Ultralow power, low distortion ADC | Analog Devices ADA4940-1 Do not place
driver, 4 nV/vHz

U3 High voltage, 1.2 MHz/600 kHz, Analog Devices ADP2370 ADP2370ACPZ-5.0-R7
800 mA, low quiescent current
buck regulator

U4 Linear regulator, 3.3V, ultralow Analog Devices ADP7118 ADP7118AUJZ-3.3-R7
noise, CMOS

ué Ultralow noise, high accuracy Analog Devices ADR4550 ADR4550BRZ
voltage reference

u7 CMOS, switched capacitor voltage Analog Devices ADM660 ADM660ARZ
converter

us IC EEPROM, 2 kb, 400 kHz, 8-lead ST M24C02-WMN6TP Digikey 497-8552-1-ND
SOIC

U12, U14 (only for Low noise, high speed amplifier Analog Devices ADA4807-1 ADA4807-1ARJZ

AD4001/AD4003)

U12, U14 (only for Low noise, high speed amplifier Analog Devices ADA4805-1 ADA4805-1ARJZ

AD4000)

uU16,U18 Low noise, high speed amplifier Analog Devices ADA4807-1 ADA4807-1ARJZ

u17 Linear regulator, 3.3V, ultralow Analog Devices ADP7118 ADP7118AUJZ-3.3-R7
noise, CMOS

u19 Linear regulator, 1.8V, ultralow Analog Devices ADP7118 ADP7118AUJZ-1.8-R7
noise, CMOS

u20 Ultralow power step-down Analog Devices ADP5300 ADP5300ACPZ-1-R7
regulator (ASHTON Lite)

u21 -28V, —=200 mA, low noise, linear Analog Devices ADP7182 ADP7182AUJ-2.5-R7
regulator

u22 Micropower, high accuracy, 5V Analog Devices ADR3450 ADR3450ARJZ-R2
voltage reference

C1,C2,C5,09,C61 10 yF, 20V tantalum capacitors AVX TAJB106K020RNJ FEC 197427

C3,C4,C16,C17,C21, 2.2 yF, X7R, 16V, 0805 capacitors, Murata GRM21BR71C225KA12L | FEC 1828829

C26 MLCC

cé 4.7 yF, 16V, X7R, 0805 ceramic Taiyo Yuden EMK212B7475KG-T FEC 1853520
capacitor

C7,C10,C12,C18, C40, 10 pF, 16V, 0805 capacitors Murata GRM219R61C106KA73D | FEC 1845747

€68, C73,C74,C75,

C76,C77

C8,C57,C64,C69,C71 | 1 pF, X7R, 50V, 0805 capacitors Murata GRM21BR71H105KA12L | FEC 1735541

C14,C15 100 nF, X7R, 25V, 0805 capacitors Murata LLL216R71E104MAO1L FEC 1294646

C24, C30,C37,C41, 0.1 uF, X7R, 50 V ceramic capacitors | Murata GRM188R71H104KA93D | FEC 8820023

C42, C44, C45,C48,

C54, C60, C66, C67, C70

C35,C52 180 pF, 50V, 0603, COG/NPO YAGEO CCO0603JRNPO9BN181 FEC 3019494
capacitors (Phycomp)

C11,C13,C19, C20, SMD capacitor Not applicable Not applicable Do Not Place

C25, C29, C32C36, C38,

(€39, C43, C46, C47,

C49, C50, C51, C55,

C63,C72

C56 10 uF, X5R, 25V, 0805, MLCC Murata GRM219R61E106KA12D | FEC 2426961
capacitor

€58, C65 2.2 uF, 50V, 0805, X7R capacitors TDK C2012X7R1H225K125AC | FEC 2346945
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Name Part Description Manufacturer Part Number Stock Code

C186 SMD capacitor EPCOS B37921C9104K60 Digikey 495-3265-1-ND

L1 1000 Q at 100 MHz, 1206, WE-CBF Wurth 742792141 WURTH 742792141
SMD, EMI suppression ferrite

L3 10 pH, inductor, shielded power, Coilcraft XAL4040-103ME XAL4040-103ME
XAL40 series

L4 2.2 pH, inductor, shielded power, Coilcraft XAL4020-222MEB COILCRAFT XAL4020-222MEB
XAL40 series

LED1 LED, SMD green OSRAM LGQ971 Digikey 475-1409-1-ND

R1 2.4 kQ, 0.063 W, 1%, 0603 resistor Multicomp MCO0063W060312K4 FEC 9330879

R2 100 kQ, 0.1 W, 1%, 0805 resistor Multicomp MCOTW08051100K FEC 9332405

R3,R11,R12,R13,R14, 0 Q, SMD resistors Multicomp MC 0.063W 0603 OR FEC 9331662

R20, R21, R23, R25, R36,

R38, R40, R42, R44, R46,

R48, R50,R51, R52, R53,

R59, R66, R68, R69, R73,

R74,R75,R77,R78,R79,

R85, R86, R90, R91, R95,

R96, R99, R100

R4, R5, R8, R9 1kQ, 0.063 W, 1%, 0603 resistors Multicomp MC0063W060311K FEC 9330380

R7 88.7 kQ, 1%, 0805 resistors Vishay Draloric CRCWO080588K7FKEA FEC 2139026

R10 1%, 0805 resistors Multicomp MCO01WO08050R FEC 9333681

R17,R22,R32, R37 49.9 (), 0.1 W, 0.1%, 0805 resistors Panasonic RN73C2A49R9BTG FEC 1140694

R24, R41 200 Q, 0.1 W, 1%, 0805 resistors Multicomp MCOTW08051200R FEC 9332758

R27, R28, R34, R35 Thick film chip resistor Vishay Draloric CRCWO0805590RFKEA FEC 1653021

R45, R65, R67 10 kQ, 0.1 W, 1%, 0805 resistors Multicomp MCOTW0805110K FEC 9332391

R93 20 kQ, 0.063 W, 1%, 0603 resistors Multicomp MC0063W0603120K FEC 9330771

R6, R15, R16, R18, R19, SMD resistors, 0603 Not applicable Not applicable Do not place

R26, R29, R30, R31, R33,

R39, R43, R49, R54, R55,

R56, R57, R58, R60, R70,

R71, R72, R76, R80, R84,

R87, R88, R89, R92, R94,

R97, R98, R101

Table 6. Evaluation Board Models

Product Ordering Model Sample Rate (MSPS) Resolution (Bits) Package Used on Evaluation Board
AD4000BRMZ EVAL-AD4000FMCZ 2 18 10-lead MSOP
AD4003BRMZ EVAL-AD4003FMCZ 2 16 10-lead MSOP
AD4001BRMZ EVAL-AD4001FMCZ 2 16 10-lead MSOP

RELATED LINKS

Resource Description

ADA4805-1 Product Page, ADA4805-1, 0.2 uV/°C Offset Drift, 105 MHz Low Power, Low Noise, Rail-to-Rail Amplifier
ADA4807-1 Product Page, ADA4807-1, Low Power, Low Noise and Distortion, Rail-to-Rail Output Amplifier

ADR4550 Product Page, ADR4550, Ultralow Noise, High Accuracy 5.0 V Voltage Reference

ADP7118 Product Page, ADP7118, 20V, 200 mA, Low Noise, CMOS LDO

ADP7182 Product Page, ADP7182, —28 V, 200 mA, Low Noise, Linear Regulator

ADM660 Product Page, ADM660, CMOS Switched Capacitor Voltage Converter

ADP2370 Product Page, ADP2370, High Voltage, 1.2 MHz/600 kHz, 800 mA, Low Quiescent Current Buck Regulator
EVAL-SDP-CH1Z Product Page, High-Speed Controller Board for System Demonstration Platform (SDP-H1)

AN-931 AN-931 Application Note, Understanding PulSAR ADC Support Circuitry
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NOTES

ESD Caution
\ ESD (electrostatic discharge) sensitive device. Charged devices and circuit boards can discharge without detection. Although this product features patented or proprietary protection
‘&'m circuitry, damage may occur on devices subjected to high energy ESD. Therefore, proper ESD precautions should be taken to avoid performance degradation or loss of functionality.

Legal Terms and Conditions

By using the evaluation board discussed herein (together with any tools, components documentation or support materials, the “Evaluation Board"), you are agreeing to be bound by the terms and conditions
set forth below ("Agreement”) unless you have purchased the Evaluation Board, in which case the Analog Devices Standard Terms and Conditions of Sale shall govern. Do not use the Evaluation Board until you
have read and agreed to the Agreement. Your use of the Evaluation Board shall signify your acceptance of the Agreement. This Agreement is made by and between you (“Customer”) and Analog Devices, Inc.
("ADI"), with its principal place of business at One Technology Way, Norwood, MA 02062, USA. Subject to the terms and conditions of the Agreement, ADI hereby grants to Customer a free, limited, personal,
temporary, non-exclusive, non-sublicensable, non-transferable license to use the Evaluation Board FOR EVALUATION PURPOSES ONLY. Customer understands and agrees that the Evaluation Board is provided
for the sole and exclusive purpose referenced above, and agrees not to use the Evaluation Board for any other purpose. Furthermore, the license granted is expressly made subject to the following additional
limitations: Customer shall not (i) rent, lease, display, sell, transfer, assign, sublicense, or distribute the Evaluation Board; and (i) permit any Third Party to access the Evaluation Board. As used herein, the term
“Third Party” includes any entity other than ADI, Customer, their employees, affiliates and in-house consultants. The Evaluation Board is NOT sold to Customer; all rights not expressly granted herein, including
ownership of the Evaluation Board, are reserved by ADI. CONFIDENTIALITY. This Agreement and the Evaluation Board shall all be considered the confidential and proprietary information of ADI. Customer may
not disclose or transfer any portion of the Evaluation Board to any other party for any reason. Upon discontinuation of use of the Evaluation Board or termination of this Agreement, Customer agrees to
promptly return the Evaluation Board to ADI. ADDITIONAL RESTRICTIONS. Customer may not disassemble, decompile or reverse engineer chips on the Evaluation Board. Customer shall inform ADI of any
occurred damages or any modifications or alterations it makes to the Evaluation Board, including but not limited to soldering or any other activity that affects the material content of the Evaluation Board.
Modifications to the Evaluation Board must comply with applicable law, including but not limited to the RoHS Directive. TERMINATION. ADI may terminate this Agreement at any time upon giving written notice
to Customer. Customer agrees to return to ADI the Evaluation Board at that time. LIMITATION OF LIABILITY. THE EVALUATION BOARD PROVIDED HEREUNDER IS PROVIDED “AS IS” AND ADI MAKES NO
WARRANTIES OR REPRESENTATIONS OF ANY KIND WITH RESPECT TO IT. ADI SPECIFICALLY DISCLAIMS ANY REPRESENTATIONS, ENDORSEMENTS, GUARANTEES, OR WARRANTIES, EXPRESS OR IMPLIED, RELATED
TO THE EVALUATION BOARD INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY, TITLE, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF INTELLECTUAL
PROPERTY RIGHTS. IN NO EVENT WILL ADI AND ITS LICENSORS BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES RESULTING FROM CUSTOMER'S POSSESSION OR USE OF
THE EVALUATION BOARD, INCLUDING BUT NOT LIMITED TO LOST PROFITS, DELAY COSTS, LABOR COSTS OR LOSS OF GOODWILL. ADI'S TOTAL LIABILITY FROM ANY AND ALL CAUSES SHALL BE LIMITED TO THE
AMOUNT OF ONE HUNDRED US DOLLARS ($100.00). EXPORT. Customer agrees that it will not directly or indirectly export the Evaluation Board to another country, and that it will comply with all applicable
United States federal laws and regulations relating to exports. GOVERNING LAW. This Agreement shall be governed by and construed in accordance with the substantive laws of the Commonwealth of
Massachusetts (excluding conflict of law rules). Any legal action regarding this Agreement will be heard in the state or federal courts having jurisdiction in Suffolk County, Massachusetts, and Customer hereby
submits to the personal jurisdiction and venue of such courts. The United Nations Convention on Contracts for the International Sale of Goods shall not apply to this Agreement and is expressly disclaimed.

©2016-2017 Analog Devices, Inc. All rights reserved. Trademarks and AN ALOG
registered trademarks are the property of their respective owners.
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